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IE-33 Controls

Introduction

Congratulations!  With your purchase of the Ivie IE-33, you not only have one of the most powerful, versatile, and
accurate audio spectrum analyzers available, but you also have an analysis system that is capable of expanding
as your needs expand.  The supplied microphone is a Type II microphone, making the standard IE-33 a Type II
measurement system.  For those needing Type I accuracy, an optional microphone, preamplifier and extension
cable is available to convert the IE-33 to a Type I system.

This manual is intended to familiarize you with the basic operations of the IE-33 Analyzer, and to whet your
appetite concerning some of its possibilities.  It is in no way intended to be the total description of all the possibili-
ties of the IE-33.

The IE-33 software runs on the Compaq© iPAQ© and requires a Jacket compatible, iPAQ 3900 series or better.
(See the IE-33 FAQ at www.ivie.com for a complete list of compatible iPAQ models).  Older units (3800 series
and below) do not have the speed and processing power to handle the IE-33 software.  Pocket PC 2003 OS is
required and ActiveSync software Version 3.7.1 or later.  The correct version of ActiveSync is on the IE-33 CD.

With reasonable care, the IE-33 will provide a long period of useful service.  Great pains have been taken to
assure performance, quality, and reliability.  We suggest that this manual be read thoroughly, and that it always
be available as a reference.  

*******NOTICE!!  POTENTIAL DATA LOSS!!*******

The iPAQ, like all PDA’s runs on battery power.  Compaq is clear in their warnings about data loss if the battery
is completely run down.  If you run the battery all the way down, your data can and will be lost!  (This has a much
harsher sound if you’ve just completed a couple of days of taking measurements when the data goes bye bye!). 

To guard against accidental data loss, there is a backup utility included in the iPAQ software suite.  The backup
utility is easy to use.  Indeed, you can schedule regular (even daily) backups that will happen automatically, or
you can start backups manually.  The Sprite Backup utility included with the iPAQ will back up to the “iPAQ File
Store” (an 8 MB non volatile storage area in the iPAQ itself), or to an SD-style memory card that plugs into the
iPAQ’s SD card slot.  Sprite also makes a separate backup utility which can be used to back up your iPAQ to the
hard drive of your PC.

We recommend that you make provision for backing up your IE-33 data on a regular basis.

IE-33 Controls

As demonstrated across the page, the IE-33 makes use of a number of different controls, both software and
hardware based.  The controls can be divided into three categories:  1)  Hardware Buttons, 2)  Software Defined
Stylus Buttons and 3)  Pop-up Menus.  Like the stylus buttons, the pop-up menus are activated using the stylus.

Hardware Buttons

The IE-33 software defines the use of the iPAQ hardware buttons as shown across the page.  The thumb button,
for example, can be used to take a memory "snapshot" when in the RTA mode.  It is also used to pause or
resume taking samples when in the Average Continuous mode and as an "add single sample" when in the
Memory Trigger mode.  These features are covered in detail in the section of this manual dealing with memory
functions.

Stylus Buttons

The stylus buttons contain many of the most used features of the IE-33.  They are clearly labeled and very intu-
itive.  Some duplicate the function of hardware buttons, as in the Zoom In and Zoom Out functions, as shown in 
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Joystick - Left/Right - Frequency selection.

Software defined buttons.  

Up/Down - dB. 
Range, dB Level.

Sound Pressure Level and 
Weighting display.

Status Window - 

Red = Function Stopped by user.

Green = Function Running.

Joystick - 

Thumb Button - Instant Memory 
Snapshot.  During Average controls 
"Pause/Resume" in continuous 
mode and "Add" in Trigger mode.

Stylus - Push to release.

iPAQ - Power On/OFF.

IE-33J - Jacket Shown with 
optional extended battery pack.                               

SD Memory expansion slot.

Charging indicator - Flashes 
while charging, on full-time when 
charging completed.

Speaker.

IE-33M - Microphone.

Audio Output Jack on Ipaq 3900 
series(3.5mm stereo) - Can be used as 
headphone jack or as output for the Signal 
Generator. 

Audio Output Jack on Ipaq 5500 
series(3.5mm stereo) - Can be used as 
headphone jack or as output for the Signal 
Generator. 

Microphone level input.




Channel 2 Line level input.

Channel 1 Line level input.





Options

IE-33 Controls



Ivie IE-33 Manual

page 4

Getting Started

the illustration on page 3.  The stylus buttons allow selection of the RTA display in octave, one third octave,
one sixth octave or maximum resolution.  The Decay stylus button adjusts the display averaging time.
Successively tapping it rotates from Decay 1, to Decay 2, to Decay 3 and back to Decay 1 again.  Many of the
averaging functions and the memory functions are controlled by the stylus buttons.

Pop-Up Menus

The pop-up menus add tremendous flexibility to the IE-33.  Tapping the "Function" pop-up menu, for example,
allows you to select one of the many functions of the IE-33.  Choices include RTA, RTA with an LED display
appearance, SPL Monitor, Seat to Seat (SPL variation), Strip Chart function, Polarity measurement,
Oscilloscope function, Signal Generator and Volt Meter.

The "Options" pop-up menu allows the setting of display scale (Set dB Scale), provides for RTA display weight-
ing, provides for the display of Peak Hold on the RTA screen, and allows the selection of NC and NR measure-
ments.  Entering a "Preferred Curve" is also done under the Options pop-up menu.

Getting Started with Your IE-33

If you purchased the IE-33 complete, you will not need to install the software in the iPAQ or calibrate the micro-
phone to the unit.  If you purchased just the IE-33J Jacket, you will need to do some preliminary work before
you can begin using your IE-33.  If you are already familiar with installing software on an iPAQ, the following
information will simply confirm what you already know.

IE-33J Jacket:  Data and Program Transfer

If you have purchased the IE-33J (jacket without iPAQ ), you will need to install the IE-33 software on your iPAQ
in order to use the jacket and make measurements.  Even if you have a complete IE-33 package, you will have
need to install software upgrades and updates as they become available.  Also, after measurement sessions,
you may wish to bring IE-33 data files across from the IE-33 iPAQ to your PC for printing or further data manipu-
lation.

All data and program transfers between the IE-33 iPAQ and your PC are done using Microsoft's ActiveSync
software.  ActiveSync is provided on the standard iPAQ CD that accompanies your IE-33 iPAQ.  Follow the
instructions provided with your iPAQ to install the ActiveSync software and create a "partnership" between your
iPAQ and your PC.  Questions about the ActiveSync communication between iPAQ and PC are supported by
HP/Compaq.  If you have problems setting up ActiveSync, contact the Technical Support numbers provided by
Compaq.

For further information on this subject, refer to Appendix III of this manual titled " Data and Program Transfer."

Beginning to Use the IE-33

As shown in the illustrations across the page, firing up an IE-33 is simple.  After sliding on the jacket and making
sure it is firmly seated, plug in the microphone.  Turn on the unit using the power button by giving it a quick
press and release.  Using the stylus, select IE-33 from the menu to begin running the software.  Next, select the
function you wish to use and you're off and running.

Microphone Calibration

If you purchased the IE-33 complete, the microphone will have already been calibrated to the unit before it left
the factory.  If you purchased the IE-33J Jacket only to use with your own PAQ, you will need to calibrate the
microphone.  For the calibration procedure, consult Appendix II of this manual titled "IE-33 Mic Calibration."
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Press power button to 
turn on IE-33.

Using the stylus tap 
on "Start."

Start using the IE-33.

 Insert the iPAQ into the IE-33J jacket 
and plug the IE-33M microphone into 

the IE-33J.

Step 2 -




Step 3 -




Step 4 -




Step 5 -




Step 6 -




Step 7 -




Step 8 -





Using the stylus tap 

on "IE-33."

The screen of the last 
used function will 

appear.

Tap the "Function" menu 
and choose the desired 

function.




Stylus - press to release.

Wait while the program 
starts and memories are 

loaded.

Step 1 -

Getting Started
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Real Time Analyzer Controls

Real Time Analyzer Controls

Stylus Buttons: The IE-33 is several instruments in the same package:  Real Time Analyzer, Sound Level
Meter, Signal Generator, Oscilloscope etc.  One of its most powerful functions is Real Time Analyzer (RTA).  To
make operation as simple and intuitive as possible, the most often used controls for the RTA are labeled stylus
buttons.  The illustration across the page shows the stylus buttons associated with the RTA.  Displays of octave,
third octave, sixth octave and maximum resolution (1024 FFT data points) are selectable as shown.

iPAQ Buttons:  The IE-33 also makes use of the buttons found on the iPAQ.  Their use is defined as shown
across the page.  The joy stick up/down function can be used to quickly adjust the display to bring the signal to
the center of the screen.  Either the stylus “Zoom In” and “Zoom Out” buttons, or the push buttons to the right of
the joy stick can be used to adjust screen resolution.

Pop-up Menus: Additionally, pop-up menus provide more features and selection capability.  Tapping the
“Function” menu on the bottom of the screen with the stylus allows the selection of the RTA function.  The vari-
ous displays of the RTA function are shown in the illustration across the page.  Below RTA in the Function menu
is “RTA LED’s.”  Selecting this function will provide a display that looks like an LED bar graph that many are so
familiar with.  The advantage of this display is that the screen resolution can be adjusted so each LED repre-
sents 1dB, 2dB or 3dB.  These increments are very useful when equalizing a sound system.

To set the level at the center of the screen (dB Level) and to adjust the dynamic range of the screen (dB per
Division), tap the "Display" menu.  Next, from the pop-up menu, select "Set dB Scale."  The window shown on
the IE-33 at the bottom of the opposite page shows this feature.  The other functions of the pop-up menus are
covered in detail in other sections of this manual.

Decay:  Display speed (averaging time) is controlled by the stylus button titled “Decay.”  Decay 1 is the fastest
response time available, with Decay 2 somewhat slower and Decay 3 being the slowest.  Decay 3 is intended
for use with pink noise.

Start/Stop Stylus Button: This button stops (freezes) the RTA and SPL displays and starts them again when
tapped a second time.

RTA Display On/Off: The RTA display can be turned on or off using the stylus button illustrated across the
page.  Green button indicates “On,” and brown button indicates “Off.”

Average Display On/Off:  The Average display (when the Average function is active) can be turned on or off
using the stylus button.  Green button indicates “On,” and brown button indicates “Off.”  A red button indicates
the Average function is not active.

Memory Stylus Buttons:  The IE-33 has 9 “scratch” memories (see the “Memory” section of this manual for
more information on memory and data storage).  To store data in a scratch memory, tap the numbered stylus
button.  A “snapshot” will be stored.  If you are in the Average mode, the average curve will be stored.  When a
memory is empty, its stylus button is red.  Memories with data in them have green stylus buttons when being
displayed and brown when not being displayed.  The last memory stored or activated for display always has a
blue stylus button.  Several memories can be displayed simultaneously and each will have its own color on the
display so it can be differentiated.  

Preferred Curve: The last stylus button in the row of memory status buttons is the memory status button for
“Preferred Curve.”  This is a very powerful function and its use is covered extensively in the section of this man-
ual titled “RTA -Preferred Curve, Display Weighting, LED Display.” 

SPL Readout Stylus Button: Tapping the SPL readout area will cause the IE-33 to step through its electrical
measurement  modes.  This is very useful for looking at voltage levels simultaneously with spectral content.
Obviously, this feature should be used when measuring electrical signal, not acoustic signals through the mic.
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The RTA can display four different resolutions.  The RTA samples at a rate of 44 kHz and 
collects 2048 data points over a 20 Hz to 20 kHz bandwidth with each frame.  When data is 
stored, ALL 2048 data points are stored.  This allows a recalled memory to be displayed in 
any resolution desired by the user.


RTA Controls

Frequency Select

dB/division display 

Tap to select desired

Resolution display 

dB/Center display dB SPL display

Tap here to select dB  



Averaging Controls

or Voltage readout 

Tap on screen or use the 

mechanical buttons to set 

dB/division

Memory Snapshot /Average

Sample button (See"Averaging"

& Memory sections of the manual)

Tap the "Options"

menu and then

"Set dB Scale"

to bring up the

dB/Center, dB division 

window

Weighting - A,C, Flat

RTA display On/Off

Average display On/Off

Store/Recall Memories

Start/Stop RTA 

dB Center UP/Down




Max Resolution 
240 points

60 - 1/6 Octave bands

30 - 1/3 Octave 
bands

10 - 1 Octave bands

(In increments set by dB/Div)
(Used in memory recall)




SPL Response - Fast,                  

Slow, Peak, Impulse

Preferred Curve Set/Display

Options

Options Options

Options Options

Options

Real Time Analyzer Controls
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Preferred Curve, LED Display, Weighting

Preferred Curve Overlay

The Preferred Curve overlay is an IE-33 feature that allows the user to create a target overlay which can be dis-
played on the screen.  This can be a valuable aid to the equalization process.  Users often use a target curve to
contour the frequency response of a system to a desired result.

Creating a Preferred Curve: The preferred, or target curve, is nothing more than a line created by the user
that is overlaid on the screen to help visualize a desired result.  To create a Preferred Curve, tap the PE memory
stylus button to the far right of the row of memory stylus buttons.  The background on the PE button will change
to white, and the RTA display will move to a special 1/3 octave display with all bars touching the center refer-
ence line. Use the "joystick" rocker button to move the blue 1/3 octave bar right or left to a 1/3 octave you wish
to change.  Use the joystick up/down to change the level of the 1/3 octave.  Move to the next 1/3 octave and
change that level, and so on.  You can create a roll-off target curve or other special spectra targets in this way. 

Tap the Preferred Curve stylus button again and the background will turn green, the button text will change to
PT (preferred target), and the preferred target curve overlay will appear on-screen. Tap the button again and the
background will change to buff while the target curve is removed from the display.  Tap the button again and it
changes to white as the Preferred Curve entry screen again appears so further editing, if desired, can be done.
Tap the button one more time and it turns green while the Preferred Curve is displayed.

Saving a Preferred Curve: The Preferred Curve you have created can be saved to the IE-33 main memory
very easily.  You can save several Preferred Curves and call them back from memory as needed.  To save a
Preferred Curve, tap the main screen Memory button, which will bring up the Memory Management screen.
Note that the default name of the Preferred Curve is "Preferred.ivi."  Tap the "Store" button immediately to the
right of the file name and you will see a dialog that allows you to change the name of the file to something more
descriptive (you can also change the file storage location if you wish).  Tap "OK" and the curve is stored.

Loading a Preferred Curve from Memory:  To load a previously stored Preferred Curve from memory, simply
tap the main screen Memory stylus button to bring up the Memory Management screen.  Memory slot # 9 is
used for storing and recalling Preferred Curves.  Tap the button labeled "Load" for the Preferred Curve memory
location and you will see a dialog that allows you to select the desired preferred curve.  Tap "OK" and the curve
will be loaded into the Preferred Curve memory location.  The IE-33 comes with one pre-loaded Preferred
Curve, labeled "Preferred.ivi" that can be loaded into the display.  It is a high end roll-off curve used as a target
for large venue sound system EQ.

LED Display: Many users are familiar with the LED display of Ivie's IE-30A analyzer.  To have the IE-33 emu-
late the IE-30's LED display, tap the "Function" pop-up menu at the bottom of the main screen and choose "RTA
LEDs."  The RTA display changes to "LEDs".  Tip: The LED display can be useful in interpreting amplitude
information on the IE-33 screen.  By setting the dB scale to 5 dB/division each LED represents one dB of ampli-
tude.  By setting 10 dB/division each LED represents 2 dB of amplitude, and by setting 15 dB/division, each LED
represents 3 dB of amplitude change. 

SPL Weighting and the RTA Display: Some users prefer to see the normal weighting filters that are applied to
SPL measurements also applied to the visual spectrum of the on-screen RTA.  The IE-33 allows you to choose
whether or not the RTA display will show an unweighted display or a weighted display.  To apply weighting filters
to the RTA display, tap on the "Options" pop-up menu at the bottom of the screen and select "RTA Weighting."
Whatever weighting filter is selected for the SPL meter when in RTA mode (the SPL meter is in the small win-
dows in the lower right of the screen) will then be applied to the RTA display.  Unchecking (by again tapping) this
selection will remove weighting from the RTA display.
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Entering a Preferred Curve Overlay

The Preferred Curve Overlay is a valuable aid to the equalization process.  It is the electronic 
equivalent of drawing a Preferred Cuve on the RTA screen with a grease pencil.  The Preferred 
Curve then provides you with an on-screen target equalization curve.

(Or how to draw a curve on your screen without using a grease pencil)

Step 1- Tap on Red "PE" 
(Preferred Empty).

Step 5- Tap on Memory 
and store it for future use. 

Relative amplitude and 
Frequency readout

The RTA display can be set to an LED 
style display using the "Function" menu 

Use the Memory button to Clear, 
Store, & Load Preferred curves.   

The SPL weighting filters "A" & "C" may be applied to the 
RTA display by using the "Options" menu.

The Preferred Curve entry 
screen will appear.

Step 2 - Use the Joystick 
Left/Right to select a 
frequency & Up/Down to set 
the amplitude until curve 
entry is complete.

Step 3 - Tap on the "PT" 
button to display the 
Preferred Curve Overlay.

Step 4 - The Preferred 
Curve Overlay is now 
displayed.  To turn off the 
display, tap on the green PT 
button.  To Edit the curve or 
turn on the display tap on 
the buff colored PT and then 
the white PT button.

RTA LED Display Applying SPL Weightings to the RTA Display

Selected frequency

No Weighting Weighting Applied5 dB/div = 1 dB/LED


10 dB/div = 2 dB/LED


15 dB/div = 3 dB/LED

Options Options Options

Options

Options Options Options

Preferred Curve, LED Display, Weighting
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RTA:  Peak Curves, Frequency Detection

Peak Hold Curves

The IE-33 will display peak information in addition to real time information in all of the display modes, Octave
through  Maximum Resolution.  The peak curve is shown in violet for the Octave, 1/3 Octave and 1/6 Octave
displays, and in white for the Maximum Resolution display screen, as shown in the illustration across the page.
The peak curve data represents the highest levels that have been reached across the spectrum.  In addition to
peak data, real time information is also displayed.

To activate the Peak Hold function and display the peak hold curve, tap the pop-up “Options” menu and select
"Peak/Hold Curve."  You can toggle through the various display formats (Octave to 1/3 Octave, etc.) while the
Peak Hold function is active.  However, when selecting different display formats, the peak hold information will
not be preserved from display to display.  Instead, it will initialize and begin again as though it had just been acti-
vated.  To turn the Peak Hold function off, select "Peak/Hold Curve"" again.  Note: If you store spectral data in
a scratch memory when the Peak Hold function is activated, real time data, not the peak curve, will be stored.

Frequency and Amplitude Detection

Several different modes of frequency and amplitude detection are provided by the IE-33.  Important Note: The
Frequency Detect indicator will operate only in the Maximum Resolution display setting and the LF Zoom display
settings.  The other frequency and amplitude detection functions will work in all RTA display formats.

For real time data, a frequency detect cursor can be activated which constantly searches the spectra and dis-
plays the frequency of the highest level found in the spectrum.  Real time data, or peak hold data, can also be
frozen using the "Stop" stylus button, and then be interrogated for frequency information using a provided cursor,
as demonstrated in the illustration across the page.  Additionally, any recalled and displayed memory can be
interrogated for frequency information in the same manner.

Frequency Detect: To activate the Frequency Detect mode (especially useful when searching for feedback fre-
quencies), tap the Max. Res. stylus button to select the Maximum Resolution display screen.  Next tap the
“Options” pop-up menu and select "Freq. Detect."  The Frequency Detect indicator will appear on screen and
begin to search for and identify the frequency registering the highest level.  To turn off the Frequency Detect
indicator, select "Freq. Detect" again.  Frequency Detect also works in the LF Zoom mode.

RTA Cursor: To activate the RTA Cursor, first tap the stylus button on the bottom left labeled "Stop."  This will
"freeze" the RTA display and the bar below the SPL readout will change from green to red.  Next, press the left
or right joy stick.    The  frequency cursor (a red + in Max. Res. or a green bar in Octave, 1/3 Octave or 1/6
Octave)  will appear on the curve.  The cursor can be moved left or right using the left and right controls of the
joy stick.  As it moves, frequency and amplitude will be indicated in the SPL readout window and all areas of
interest can be interrogated.  To turn off the RTA Frequency Cursor, tap the "Start" stylus button to return the IE-
33 to its real time display. 

Peak Cursor: When the "Peak Hold Curve" is being displayed, peak hold data can be interrogated using the
Peak Cursor.  To accomplish this, first turn on the Peak Hold Curve by selecting it from the”Options” pop-up
menu.  Next, tap the "Stop" stylus button.  When the display has been stopped, select "Peak Cursor" from the
“Options” menu.  The joy stick can then be used to move left or right along the spectrum to interrogate the Peak
Curve for frequency and amplitude information.  Selecting "Peak Curve" again turns off this function.

Memory  Cursor: This function works identically to the Memory Cursor.  To activate the Memory Cursor,  tap a
memory stylus button to recall the memory of interest.  With the memory display on the IE-33 screen,  tap the
“Options” pop-up window and select "Memory Cursor."   The Memory Cursor will appear on the curve.  The cur-
sor can be moved left or right along the curve by using the left and right controls of the joy stick.  As it moves,
frequency and amplitude will be indicated.  To turn off the Memory Cursor, select "Memory Cursor" from the
“Options” menu again.
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RTA Cursor

To display the cursor, tap the 
"Start/Stop" button to freeze the 
display then use the Left/Right 
Joystick to position the cursor.  
Only the cursor selected in the 
menu will be displayed.  If the 
Peak Cursor is not selected, the 
RTA cursor will be shown. 

The "Frequency Detect" will 
show the frequency of the FFT 
Bin in which the highest 
amplitude occurs.  This is 
extremely helpful when using a 
parametric equalizer to EQ 
feedback frequencies.  

RTA/Peak Hold Curves, Stopped 
with Peak Hold Cursor diplayed.

RTA/Peak Hold Curves, Stopped 
with RTA Cursor diplayed.

There are many display options in 
the "Max Res" mode.  Along with 
the RTA curve, the Peak Hold 
curve can also be displayed.  




TO CLEAR THE "PEAK HOLD" 
curve tap the "Clear Button."




DISPLAY of Cursor Frequency and  
Level.




Peak Hold & RTA Curves RTA Curve with Frequency 
Detection display "On"

RTA Curve

Options

Options

Options

Options

Options

OptionsOptions

RTA:  Peak Curves, Frequency Detection
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RTA:  Memory Functions

Memory Functions

The IE-33 memory system provides all of the tools necessary to save various types of files to memory, rename
files, load files from memory, examine memory data, and subtract one curve from another.  Almost all memory
system operations are performed using the memory stylus buttons and the memory management screen. 

Memory Control Buttons: The memory stylus buttons are located immediately below the RTA display screen. 
The row of twelve buttons allows both control of what is viewed on-screen, and the ability to store data in
"scratch memories."  The far left "R" button toggles "on" or "off" the real time display.  The "A" stylus button 
controls the display of the Average curve.  Stylus buttons 1 - 9 alternately store, remove from display, and
restore to display the contents of the nine Scratch memories.  The "PE" stylus button controls "Preferred" or
"Target Curve" functions.

Stylus Button Colors: If a stylus button is red, there is nothing stored in the memory or display location asso-
ciated with the button.  If the button is green, there is data present and it is being displayed.  Blue is identical to
green, that is, there is data present and it is being displayed.  However, blue also indicates that this is the last
memory location to be manipulated.  This blue color is very useful in keeping memories straight, especially when
using the thumb-push button instead of the stylus buttons to store data.  Finally, if a button is buff colored, there
is data stored in that memory location, but not displayed on-screen (tapping a buff stylus button will display the
data associated with that button and change the button color to blue).

Scratch Memories: Scratch memories are "scratch pad-type" storage memories where you can temporarily
store curve data until you decide to rename and store the data permanently.  You can store the RTA data you
are observing to a scratch memory by tapping a scratch memory stylus button, or you can depress the "thumb
button" on the side of the iPAQ.  Using the thumb button is convenient and provides automatic, sequential stor-
age of data in scratch memories 1 through 9.

Memory Management: Tap the "Memory" stylus button to access the memory management screen.  The mem-
ory management screen allows you to store, load, and clear files from scratch memories, Preferred Curve mem-
ory, subtraction memory, and peak memory.  Select a memory location you wish to store and tap the adjacent
"Store" button.  You will be prompted to provide a more descriptive name for the file you are about to store.  You
can also change the location to which the file will be stored, if you wish.  Tap "OK" and the contents of the
scratch memory will be stored under the name and in the location of your choice.  To clear a scratch memory
with or without storing it, tap the adjacent "Clear" button.  A stored curve data file may be loaded into a scratch
memory location by tapping the "Load" button, selecting the file to be loaded, and tapping on the file name.
Stored Peak and Subtraction data files may also be loaded into scratch memories.

Subtract Feature: The IE-33 provides a powerful function which allows the user to subtract one curve from
another.  A stored scratch memory curve can be subtracted from the real time display, or one scratch memory
curve can be subtracted from another, or from an Average curve.  Tap the "Subtract" stylus button to access the
subtract control screen.  Here you can choose which spectrum you wish to subtract from another.  Upon tapping
"S1 - S2" the RTA display returns with a "0" center reference and yellow RTA bars.  You are viewing the one
spectrum subtracted from the other.  To return to normal RTA, tap the Subtract stylus button and tap "Cancel."

Peak Storage: When displaying the "Peak Hold" curve in the RTA, you can open the Memory Manager and tap
"Store Peak" to store this peak information in the peak spectrum scratch area.  From here you can rename it
and store it permanently.  Stored peak curve data can be loaded into any of the nine scratch memories via the
Memory Manager.  Just select a scratch memory and tap "Load."   Next, select the peak memory to be loaded.

Memory File Format: Data stored in files can be moved to the PC using the standard Microsoft ActiveSync
software provided with the iPAQ.  The IE-33 always stores data in full resolution of 1024 data points across the
spectrum. Using Ivie's supplied "IvieXLS" software and Microsoft Excel, you can display, manipulate, and print
data.  The file format for stored data consists of a file header and four columns of ASCII text and number char-
acters.  The 4 columns are: 1: Hz (label), 2: Datum frequency, 3: dB (dB label), 4: Amplitude at that frequency.
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Step 1 - Tap an empty Scratch 
memory location 1 - 9 (colored in 
Red).  The curve will appear on the 
screen and the Scratch memory 
background color will turn Blue 
indicating it is now filled and being 
displayed.



Tap the Blue Scratch memory to                 
remove the stored curve from the 
display.  The background color will 
turn to Buff indicating that the 
memory is filled but not presently 
displayed.





Store a curve to memory

Step 2 - To store a Scratch memory to the 
main memory, tap on the "Memory" control to 
bring up the memory management screen.

Blue = Scratch memory #3 displayed.

Red "A"= No Average curve is stored.

Green "R" = RTA curve is displayed. 




From this screen you can "Store" a Scratch memory to 
main memory or "Load" a memory from main back into 
a Scratch memory.  Preferred, Peak and Subtraction 
memories can also be "Stored" and "Loaded."




Re-name a memory 
from "Scratch" to a more 
descriptive name and 
tap on "OK."




Tap on a memory file to 
move it into a Scratch 
memory so it can 
displayed.




Step 3 - The result will be displayed in 
yellow on the screen.  To exit this mode, tap 
on "Subtract" and then "CANCEL."


Step 2 - Select two 
sources or 
spectrums for 
comparison: 
Scratch Memory, 
Preferred Curve, 
RTA Display or 
Average and then 
Tap "S1 - S2."


Step 1 - Tap 
on the yellow 
"Subtract" 
control.


Step 1 - Tap on "Options" then "Memory 
Cursor." 

Step 2 - Tap on "Stop." 

Step 3 - Turn RTA display On/Off as desired.

Step 4- Use Left/Right Cursor to select the 
frequency.


Buff colored 1, 2, 4 & 5 = Curves are 
stored in these memories but they are 
not currently being displayed.



Red colored 6, 7, 8 & 9 = These 
Scratch memories are empty and 
available for curve storage.



Red "PE" Preferred curve not stored.


Memory #3 being displayed

Subtract / Display Two MemoriesMemory Cursor

dB

Freq

Options

Options

Options

Options Options

RTA:  Memory Functions
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NIC and (F)STC Measurements

NIC and (F)STC Measurements

Sound  transmission field testing of operable walls and field partitions is almost exclusively done using ASTM

E336 as the standard.  The IE-33 is currently capable of making Noise Isolation Class (NIC) measurements.

NIC measurements are normally specified  rather than Field Sound Transmission Class (F)STC measurements

because they are faster, easier, and therefore, less expensive to make.  Field Sound Transmission Class

({F}STC) measurements require RT60 information for the calculation, as well as receiving room absorption in all

sixteen 1/3 octave bands of interest.  At the time of this manual writing, the IE-33 is capable of measuring

receiving room absorption in the required sixteen 1/3 octave bands, but  RT60 measurement capability is under

development, and not yet available.  While some accommodation for (F)STC measurements is in the current

software, making (F)STC measurements will not be possible until RT60 measurement capability is added to the

IE-33.  The following instructions are therefore limited to the theory of NIC measurements and making  NIC

measurements. 

NIC is a single-number acoustical rating of sound isolation between two different spaces separated by a sound

barrier.  A typical measurement example would be determining the sound isolation provided by a wall or mov-

able partition separating two rooms.  To make the measurement, an omni-directional sound source would be

placed in the Source Room to energize it with pink noise.  Averaged (power averaged), 1/3 octave RTA spec-

trum measurements would then be made on both sides of the wall (Source Room and Receiving Room) and

each room average would be stored to separate memory locations.  The NIC calculation would begin as the

stored spectrum of the Receiving room is subtracted from the stored spectrum of the Source Room to create a

Transmission Loss (TL) curve.

The NIC rating would then be determined by comparing and shifting the TL curve relative to the standard NIC

contour such until the TL curve is never more than 8 dB below the NIC contour in any 1/3 octave band; and the

sum of the deficiencies below the contour over the 16, 1/3 bands, does not exceed 32 dB.  Once the TL curve is

shifted to meet these criteria, the NIC rating is determined by the value of the NIC contour at 500 Hz.  Once the

Source Room and Receiving curves are stored, the curve fitting and NIC calculation are all done automatically

by the IE-33.  Only a few taps of the stylus are required to complete the measurement and display the results.

The step-by-step process for making an NIC measurement is demonstrated by the illustrations on the opposite

page.

Real Time NIC Measurements 

This is a very useful diagnostic tool offering, unique to Ivie instrumentation.  This mode allows the user to com-

pare the stored average curve in the Source Room to real time data in the Receive Room, thus providing a run-

ning  calculation of NIC in real time.  While in the Receive Room, the microphone can be moved to any position

around the sound barrier to find "sound leaks", weak isolation areas, strong isolation spots etc.  Because the

NIC curve and calculated number are continuously updated in real time, it is easy to quickly compare different

areas, thereby determining deficiencies relative to location. 
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Step 1- Under the "Function" menu select "RTA".

Step 1- Under the "Function" menu select "RTA"

Step 1- Store real time spectrum in

memory #1.



Step 2 - Press the "Subtract/STC" 

button.



Step 3 - Select memory #1 in the "S1" 

column and "R" in the "S2" column.



Step 4 - Press the (F)STC/NIC(S1-S2) button.

Step 2- Make certain the Average mode is set to "Average-P" 

(File>Preferences>Power Average).

Source Room

Omnidirectional

Sound Source

Measurement

Points @1 Meter


from the wall

Receiving Room

Store RTA averaged 

spectrum in Memory #1

Store RTA averaged 

spectrum in Memory #2




Step 3- Turn on the sound source.  In the Source room, go to a 

position one meter away from the wall and press the "Average-P" 

button. Move along the wall as samples are taken.  Press the 

"Pause" button when you reach the end of the wall.

Step 4- Store the Average to Memory #1 and then press the

 "Count=" button to clear and reset the Average.

Step 6- Store the Average to Memory #2 and then press the "Count=" button to clear and reset the Average.

Step 7- Press the "Subtract/STC" button to bring up the Subtract/STC screen.

Step 8 - In the "S1" column select 1(which is memory #1) .  In the "S2" column select 2 (which is memory #2). 

 Now press the (F)STC/NIC(S1-S2) button.


Step 9 - To return to the RTA screen press the "Subtract/STC" button and then the "Cancel" button. 


Step 5- In the Receiving room, go to a position one meter away from the wall and press the "Average-P" button. Move                    
along the wall as samples are taken.  Press the "Pause" button when you reach the end of the wall.

Store 2 Measurements and

press the "Subtract/STC button

Display the NIC Curve

and Value

Select the two memories 

and press this button








The IE-33 can perfom "Real Time" NIC measurements.  The real time spectrum measurement in the Receiver room is 
subtracted from the spectrum of the Source room stored in memory #1.  This mode is unique to Ivie.  You can use it 
as a "sniffer" to help locate leakage paths.




REAL TIME NIC or Sniffer Mode

How make an NIC measurment

Options

Options

Options

NIC and (F)STC Measurements
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Real Time Analyzer:  Average Mode

Average Mode

The IE-33’s Average Mode offers very powerful features that allow you to create continuous or triggered
averages of various types, as well as select the type of average that best suits your measurement.

Continuous Average Mode

In the RTA mode, tap on the “Average-A”  stylus button.  The default condition for the stylus button below the
Average button is “Cont.”, which indicates that you will be starting with a continuous average.  When you tap the
Average-A button, the button text changes to “Count = X," where "X" is the number of samples so far collected.
You will see the sample number increment as the number of automatically collected data samples increases. 

A blue line will immediately form on the RTA screen, which is the graphic representation of the average that is
being collected.  The more samples collected, the slower this average display will change as short duration
acoustic events are encountered.

In Continuous Mode, the data sample collection can be paused by tapping Pause/Resume stylus button, or by
pressing the mechanical Thumb Button on the side of the iPAQ.  Tapping the stylus button again, or pressing the
Thumb Button again, continues the sample taking process.

You may switch the screen presentation between 1/1, 1/3, 1/6 octave and Max Res at any time during an
Average measurement.  However, doing so will reset the data sample counter to zero and start the averaging
process over again.

Triggered Average Mode

Tapping the “Cont.” stylus button will switch it to “Trigger.”   In this mode, data samples for averaging are taken
only when the user manually triggers a sample.  Triggering a sample can be done by tapping the “Add” stylus
button, or by using the mechanical Thumb Button on the side of the iPAQ.  Each time a data sample is added by
triggering a sample, the sample count on the Average button will increment by one.

You can manually clear an Average Curve and reset the data sample counter to zero at any time by tapping the 
“Clear” button.  To exit the Average mode tap the “Count-X” stylus button.

Average Type Selection: The IE-33 Average Mode offers the power of two types of averaging.  The Arithmetic
Average (Average-A) does straight arithmetic averaging.  This type of average is probably best when you are
viewing the RTA screen while doing active equalization or other dynamic spectral adjustments.  The user may
switch the averaging mode to “Power Average (Average-P), which is probably most useful in measurements
where the total power is more important, such as transmission loss.  Switching from Average-A to Average-P is
done by tapping the "File" pop-up menu.  Select "Preferences" next,  and from that pop-up menu, select either
Power Average or Arithmetic Average.

Viewing an Average Curve: While the average is being taken, the blue average line is seen in the RTA screen. 
To see this line more clearly, you can temporarily remove the real-time data from the display.  This is done by
tapping the green “R” button immediately below the RTA display (see figure on the opposite page).  Don’t forget
to turn the real-time display back on when you’re done . . . It’ll save you a call to Ivie IE-33 Tech Support!

Storing and Loading an Average Curve: When an Average Curve is displayed on the RTA screen,  it is what
will be stored when you choose to store a curve.  With this in mind, an Average Curve is stored in the same way
any other spectrum is stored.  Simply select an empty scratch memory location (red stylus buttons indicate
empty memory locations) and tap it.  The Memory Manager ("Memory" stylus button) allows the storing of any
scratch memory.  Similarly, stored curves can be loaded into any standard scratch memory location by opening
the Memory Manager and selecting “Load” for any of the scratch memory locations.
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Continuous Mode Tigger Mode




Step 1 - Select either the Continuous 
(Cont.) or Trigger mode for 
Averaging.



The Continuous mode will 
automatically take sample after 
sample until the "Pause/Resume" 
control is pressed.



The Trigger mode will take only one 
sample each time the "Add" control is 
pressed or the Thumb button on the  
side of the IE-33 is pressed.




Green = Display On




Buff = Disp Off




Green = Disp On

To Select Averaging Method

1 - Tap "File."

2 - Tap "Preferences."

3 - Tap either "Power Average." 

 or "Arithmetic Average."

Real time "R" and Average 

"A" displays turned on.

Real time "R" display Off 

Average "A" display turned on.

Step 2  - Tap on the "Average-P" 
control to enter into Average mode.


Step 3  - The "Average" display will be replaced with a "Count=X" display, 
with X= the number of samples taken. In the Trigger mode the Count will 
be incremented with each tap of the "Add" control.  In the Continuous 
mode the Count will be controlled by the "Pause/Resume" control.



Step 4 - Store the Average curve by selecting any un-used scratch 
memory.  If you wish to store the real-time curve instead of the Average 
curve, turn off the Average curve display before pressing the Scratch 
Memory Store control. 



Tap "Clear" to Clear the Average curve and reset the Count to zero. 

Tap "Count" to Exit the Average mode.


Average Curve

With Average 
curve displayed, 
press an empty 

(red color) Scratch 
Memory to store.

Options

Options Options

Options Options

Real Time Analyzer:  Average Mode
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RTA: Noise Criteria & Noise Rating (NC, NR)

Noise Criteria (NC) and Noise Rating (NR) Measurements

The IE-33 is equipped to make quick, accurate Noise Criteria (NC) and Noise Rating (NR) measurements.  NC
and NR are measurement protocols which allow the consultant or contractor to quantify the ambient, or quies-
cent, noise level of the room being measured.  Many rooms that are designed by consultants are designed to an
NC or an NR specification, and NC/NR measurements are designed to confirm or certify that the acoustic and
mechanical design meet the required “level of quiet.”

Making an NC measurement with the IE-33 is very simple.  From the IE-33’s RTA screen, tap on the “Options”
pop-up menu at the bottom of the screen.  Then tap on “NC” to activate the NC measurement screen.  The RTA
screen then automatically configures for NC measurements.  You will note that the IE-33 switches to the one-
octave display and the RTA/SPL weighting reverts to “Flat.”  Both of these settings are required for NC measure-
ments.  You will also notice that the “NC Overlay Contours” are shown on the screen.  These lines represent the
spectral contours that denote the various NC levels.

The NC contours can be “manually read” to determine the NC level.  Making certain that there are no extrane-
ous noise sources in the room (the room should be as quiet as it can be), activate the NC screen.  Determine
the NC line that is closest to, but not touched by, the octave RTA display bars.  This line represents the NC level
of the noise in the room or space being measured.  

Note: NC levels are read in 5 dB increments.  For example, there is technically no such thing as an NC 47.
Only NC 45 or NC 50.  Many individuals, as a matter of practice, refer to NC numbers between the 5 dB levels,
and this can be useful, but it is not technically correct.

The IE-33 makes the job easier.  Instead of interpreting the movement of the octave bars, you can observe the
NC number which the IE-33 calculates and displays in the lower-right SPL window.  This number will show the
NC in dB increments, though the “official” measurements are in 5 dB increments.  To make a “correct” NC meas-
urement using the NC numbers calculated by the IE-33, one need only round up to the nearest 5 dB increment.

Another Note:  The maximum NC number in the NC protocol is NC 65.  Any level above that does not fit in
the range of NC measurement.  If the noise level of the space being measured is above NC 65, the calculated
NC number will display “NC++”.

NR Measurements are made in exactly the same way NC measurements are made, but the NR Overlay
Contours are slightly different.  Neither NC nor NR is better than the other; they are just slightly differing stan-
dards.  In various regions and countries, one is favored over the other.  The consultant or contractor needs to be
able to measure to both standards in order to meet the needs of both specifications.

To activate the NR measurement screen, go to the “Options” pop-up menu and select “NR.”  From that point, the
instructions for NC and NR are pretty much interchangeable.

NC & NR Averaging: It may be useful to use an averaged octave spectrum for making NC or NR measure-
ments.  To do this, activate the NC or NR screen, and then tap the Average button.  Activate the Continuous
Average button (see instructions for Averaging).  The average function will begin taking samples and create a
blue average spectrum line.  When the Continuous Average function is active, NC and NR measurements are
being calculated from the relationship of the average octave display (blue line) to the NC or NR Overlay
Contours.

If you switch off averaging, the calculated NC or NR number will revert to making its calculations from the real-
time octave bars.
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Making a Noise Criteria (NC) Measurement




Step 1 - While in the RTA 
Function, under the "Options" 
menu select "NC".  Don't worry 
about the RTA weighting as it will 
automatically be set to "FLAT."

Step 2  - Read the NC value 
in the SPL window.



Note: Any NC value over 65 
will be displayed as NC++.

Should you desire, you can 
activate the averaging function and 
then the NC will be calculated from 
the Average curve.

Step 1 - While in 
the RTA Function, 
under the "Options" 
menu select "NR".  
Don't worry about 
the RTA weighting 
as it will 
automatically be set 
to "FLAT."

Step 2  - Read the NR 
value in the SPL window.



Note: Any NR value over 
65 will be displayed as 
NR++.

Should you desire, you can 
activate the averaging 
function and then the NR will 
be calculated from the 
Average curve.

Making a Noise Reduction (NR) Measurement

OptionsOptions

Options Options Options

Options

Options

RTA: Noise Criteria & Noise Rating (NC, NR)



Sound Level Measurement

Introduction

The decibel (dB) scale has been adopted internationally for use with sound level meter testing.  The scale
begins at a reference of 0 dB in sound pressure level (0 dB SPL) which corresponds to the smallest sound that
can be heard by a healthy human ear, and is equal to 2µN/m2, or perhaps more commonly,  20µPa.  To get a
better idea of relative sound levels, consider the following:  Quiet outdoors in the country would measure around
10dB, a very soft whisper about 30dB and average conversation around 70dB.  An automobile horn would weigh
in at approximately 80dB, a jackhammer around 100dB and a small aircraft engine roughly 120dB.  The thresh-
old of pain is about 140dB.

When studying sound level measurements, it is of major importance to understand the response characteristics
of the human ear.  Our ears do not respond equally to all the frequencies of the audio spectrum - in other words,
they are not "flat" in their response.  To further complicate matters, the response characteristics of human ears
change with different SPL's.  At relatively quiet SPL's, our ears attenuate high frequency sounds to some
degree, and drastically attenuate low frequency sounds.  As SPL's increase, our ears get more efficient at low
frequencies and their response to sound becomes more "flat,"  although they never achieve a totally "flat"   
response.  Following is a set of curves which approximate the "A" and "C" curves, or the hearing response of
human ears.  The "A" curve shows how ears hear, or perceive sound at low SPL's, while the "C" curve shows
how we hear at relatively high SPL's.

Level
in dB

0 

-10

-20

-30

-40

-50

20                  50        100                               500       1K                               5K       10K       20K

Frequency in Hz

These curves have been integrated into sound level meters for testing sound levels.  "A" weighted (dBA) meas-
urements use the "A" curve above, "C" weighted (dBC) use the "C" curve above, and "Flat" (dB SPL) measure-
ments use no weighting at all.
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Sound Pressure Level (SPL)
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Tap to select different Weighting Filters to 
be applied to the SPL Meter.
Tap to select different detector response 
times for the SPL Meter.

In the "Peak Hold" mode the SPL meter 
will capture and hold the highest SPL 
reading.  The "RESET" control must be 
tapped to clear and reset the SPL display 
for subsequent readings.   

A

A

Sound Pressure Level in 
dB SPL with "A" 

Weighting Filter Applied. 




Set the IE-33 for "Slow" response.

Set the IE-33 for "A" Weighting.

Read the SPL dB(A) in the SPL window. 


Step 1 -

Step 2 -

Step 3 -


Make an SPL Measurement

Typically "A" Weighting is used because it approximates how humans perceive sound             .  
The "Slow" Response is good for measuring sound levels of a continuous nature.  

Options

Sound Pressure Level (SPL)
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Sound Pressure Level (SPL) Monitor

Making SPL Measurements

The IE-33, as depicted on the opposite page, can make all the measurements required by domestic and interna-
tional standards, including A, C and unweighted SPL measurements.  In addition to weighting, various detectors,
again specified by domestic and international standard, can be selected for SPL measurement.  These detectors
include Fast, Slow, Peak and Impulse.  The Fast and Slow detectors are true RMS with different averaging
times.  Peak is, in fact, a true peak detector, and quite fast.  Impulse is a combination of an extremely fast peak
detector followed by an RMS buffer and is intended for measurement of extremely short duration phenomena.

The Slow detector, in  combination with A weighting,  is normally used for making sound level measurements
related to noise associated with hearing damage.  OSHA and other regulatory SPL measurements are normally
written around A weighted, Slow.  It has been determined that high A weighted sound levels are more damaging
to human hearing than C or unweighted levels.

System Calibration for OSHA Measurements

OSHA measurements generally require equipment that meets minimum specification standards - at least an
ANSI Type II sound level meter, for example.  The IE-33, with its supplied IE-33M microphone, is a Type II
sound level meter, and therefore satisfies OSHA minimum requirements.  The electronics of the IE-33 meet Type
I specifications, however.  With the addition of an optional Type I microphone and preamplifier, the IE-33
becomes a Type I measurement system.

In addition to the equipment meeting minimum specification standards, it must also be properly calibrated in
order for an acceptable OSHA measurement to be made.   What this normally requires is calibration prior to the
measurement, and then a recheck of calibration after the measurement is made.   In the case of SPL measure-
ments, a calibration device (either a pistonphone or an acoustic calibrator) must be used.  The standard IE-33M
microphone is a 10mm diameter, electret condenser microphone.  It can be calibrated with any quality calibration
device that will accept a 10mm adapter.  Most calibrators have a larger diameter opening to accommodate
microphones up to one inch or slightly larger in diameter, and have plug-in adapters to reduce the opening size
for smaller microphones.  The Ivie Type I microphones, along with many other international standard air con-
denser microphones, are 1/2 inch in diameter and require the use of a 1/2 inch adapter when calibrating.  With
either Ivie microphone, the same calibration process applies.  It is important that the microphone fit snugly inside
the adapter to assure accurate readings during calibration.  

For complete information on calibration, see Appendix II of this manual dealing with this subject.

Sound Pressure Level (SPL) Monitor

The IE-33 normally displays SPL readings in the lower-right corner of the display screen, as shown in the illus-
tration across the page.  Immediately below the level readout, the weighting is displayed (A, C or Flat).  The
detector selected is displayed on the blue colored stylus button in the center column of stylus buttons (Fast,
Slow, Peak or Impulse).

There are occasions when a much larger SPL display may be desirable.  The "SPL Monitor" function provides
this.  To access SPL Monitor, tap the "Function" pop-up menu and then tap "SPL Monitor" to activate this func-
tion.  The large SPL display shown across the page will appear.  The SPL at a resolution of 1dB will be dis-
played in very large, easy to see numbers.  The smaller SPL readout in the lower-right of the screen will also
continue to function, providing its .1 dB resolution readout.

There is also a convenient bar graph display shown along with the large numerals.  You can program this bar
graph to change colors at specific sound pressure levels.  To do this, while in the SPL Monitor mode, tap the
"Options" pop-up menu and select Set dB Levels.  The level for color change can then be set as shown in the
illustration across the page.  The bar graph will change from green to yellow at the lower level programmed, and
from yellow to red at the upper level programmed.  This feature can be extremely useful in some applications.
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The large SPL display combined with a bar graph that changes colors at 
user defineable set points facilitates SPL Monitoring of "live sound" events. 

Set the controls to "Slow" and "A-Weighted."




Entering the Set points

1 -Tap "Options" and then "Set dB                         
Levels."

2- Set dB Lower set point.

3- Set dB Upper set point.

4- Tap the "ok."

TIP! - The iPAQ charging cradle can hold the IE-33, jacket and all.   When 
placed on a mixing console or desk top, the cradle holds the IE-33 at a 
convenient viewing angle and can power the IE-33 and charge its batteries 
at the same time.




Tap to select different Weighting Filters to 
be applied to the SPL Meter.
Tap to select different detector response 
times for the SPL Meter.

Options

Options

Options

Sound Pressure Level (SPL) Monitor
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Sound Pressure Level (SPL) Seat-to-Seat

The large numeral SPL reading reflects the results of the detector selected (Fast, Slow, Peak or Impulse), and
the weighting selected (A weighted, C weighted or Flat).  In addition, the SPL Monitor function provides level
monitoring in octave band levels.  Technically, octave band readings are level measurements and not SPL
measurements, since SPL is, by definition, a broad band measurement.

Monitoring of octave band levels is possible in the following octaves:  125 Hz, 250 Hz, 500 Hz,1 kHz, 2 kHz and
4 kHz.  To select one of these octave centers, tap the green "Weighting" stylus button.  It will toggle with succes-
sive taps from Flat to A weighted, to C weighted, to 125 Hz, 250 Hz , 500 Hz, 1 kHz, 2 kHz and 4 kHz, and back
again to Flat.

Sound Pressure Level (SPL) Seat-to-Seat

One of the highly useful functions of the IE-33 is the measurement of Seat-to-Seat variation.  This function can
be used to measure the uniformity of sound level throughout a venue.  The Seat-to-Seat function allows you to
set a reference level, which then becomes equated to 0 dB.  As you move throughout the venue, level in dB
above or below the reference level is clearly indicated.  As shown in the illustration across the page, Seat-to-
Seat variation is displayed in large numerals.  

Additionally, there is a bar graph that displays Seat-to-Seat variation up to plus or minus 12 dB.  There is also a
numeric readout which displays maximum deviation, the same data as the bar graph, except that it is not limited
to a range of plus or minus 12 dB.  Of course, absolute SPL is also shown immediately above the maximum
deviation readout.

The large numeral SPL reading, as well as the bar graph and the maximum deviation readout, reflect the results
of the detector selected (Fast, Slow, Peak or Impulse), and the weighting selected (A weighted, C weighted or
Flat).  In addition, just as in the SPL Monitor function, the Seat-to-Seat variation function provides level monitor-
ing in octave band levels.  

Monitoring of octave band levels is possible in the following octaves, as shown in the display across the page:
125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz and 4 kHz.  To select one of these octave centers, tap the green
"Weighting" stylus button.   It will toggle with successive taps from Flat to A weighted, to C weighted, to 125 Hz,
250 Hz, 500 Hz, to 1 kHz, to 2 kHz, to 4 kHz and back again to Flat.

Making a Seat-to-Seat Measurement

To make a Seat-to-Seat deviation measurement, tap the "Function" pop-up menu and select "Seat-to-Seat."
Next, with steady-state noise playing in the venue, select a representative spot as the reference.  Once a repre-
sentative spot is located, establish it as the reference by carefully tapping the "Reset" stylus button.  (This
"Reset" reference level will be remembered by the software even if Seat-to-Seatt screen is left, but will not be
retained once the IE-33 software program has been exited).  Hint: Tapping the "Reset" stylus button roughly will
cause microphonic noise to travel through the IE-33 (like tapping a microphone with your finger) which will ele-
vate the noise level seen by the IE-33, thus setting a "false" reference level.  Once the reference level has been
set, walking the venue will clearly indicate the level variation at various locations within the venue.  

The type of venue will help determine the settings for the IE-33 when measuring Seat-to-Seat variation.  The
majority of venues will likely be measured in Slow response, as opposed to Fast or Peak.  The bandwidth and
weighting applied are more likely to change from venue to venue.  If the system is intended for music reinforce-
ment, you may want to measure Seat-to-Seat in the Flat mode to assure full-range uniformity from Seat-to-Seat.
You may also wish to measure the same venue A weighted if there are concerns about it meeting local noise or
sound level ordinances, which will likely be written around A weighted measurements.

On the other hand, venues intended primarily for voice reinforcement may likely be "rolled off" on the high end
as well as the low end.  It is not unusual to encounter Seat-to-Seat measurement specifications written around
band limited noise center at 4 kHz.  The IE-33 meets this requirement nicely.
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Set the IE-33 for "Slow" response and "2 kHz" filter weighting.

Energize the sound system with pink noise with the SPL in the room at least 10 dB 
above the ambient noise.

Go to the first measurement position and press the "Reset" button to zero the meter to 
that position. 

Walk from seat to seat over the first coverage area and then note the Maximum and 
Minimum SPLs measured.  This measures the Seat-to-Seat variation for that area.

Go to the next area, press "Reset" and make a new measurement.


Step 1 -

Step 2 -



Step 3 -



Step 4 -



Step 5 -

Real time, absolute value of SPL. 

Maximum SPL (+) deviation from zero, 
relative to the last time the "Reset" button 
was pressed.

Minimum SPL (-) deviation from zero, 
relative to the last time the "Reset" button 
was pressed.

Current +/- SPL deviation from zero, 
relative to the last time the "Reset" button 
was pressed.

Tap to select different Weighting Filters to 
be applied to the SPL Meter.

Tap to select different detector response 
times for the SPL Meter.

Pressing the "Reset" button clears all 
Min/Max and Current data and sets them 
to Zero at the moment of the button press.  
From that moment forward, the Minimum, 
Maximum and Current displays show the 
+/- SPL relative to when the meter was 
"Zeroed Out" (Reset button pressed).

Graphic representaion of Min/Max and Current SPL deviation from zero.  The 
green box represents the Min/Max and the blue bars the Current deviation.  This is 
reset whenever the "Reset" button is pressed.

Options

Options

Sound Pressure Level (SPL) Seat-to-Seat
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Strip Chart Recorder

Strip Chart

The Strip Chart feature of the IE-33 harks back to the days of pen on strip chart paper.  We still find this type of
visual presentation to be one of the clearest and easiest to “digest” when looking at amplitude over time.  With
Strip Chart, it is possible to record and review variations in amplitude over times ranging from a minute to eight
hours.  Data collected in Strip Chart measurements can be viewed on-screen and/or on the PC, or can be
stored for later analysis.

To begin making a Strip Chart measurement, first select the desired weighting or filtering for the recording.  Flat,
A, or C weighting may be selected.  Additionally the measurement can be band limited to one of several octave
filters (125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, or 4 kHz).  This can be useful in crafting a measurement that will
be meaningful for the purpose intended.

Next, select the broadband SPL response detector.  The standard Type I SPL detectors (Fast, Slow, Peak and
Impulse) can be selected.  Impulse would rarely be used.  Fast and Peak provide very useful data for analysis,
and Slow would be used for most environmental noise measurements, as many OSHA and other regulatory
measurements specify A weighted, Slow measurements.

The final set-up requirement for making a Strip Chart measurement is to select the length of the recording
desired.  This is chosen by making a selection in “Chart Time” (Options> Chart Time).    Additionally, you can set
visual minimum and maximum indicators with the Set dB Levels (Options > Set dB Levels) boxes.  This gives a
visual indication when levels go above or below the levels you have set, and can be very useful locating "prob-
lem levels" at a glance.  If you select a recording time longer than five minutes, it will be important to con-
sult Tip #2 below.

In the "Options” pop up menu, you can also select the vertical display dB/division (this can also be done with the
left-most two mechanical buttons on the iPAQ).  The dB/Div and recording time are shown in the upper left of
the main display window.  

Once all the selections are made, you can “drop the pen” onto the “paper” by tapping “Start.”  It is possible to
stop the recording at any time by tapping “Stop.”  At the end of the designated recording time it will automatically
stop and present a screen to name and store the recorded measurement.

Reviewing a recorded Strip Chart measurement is intuitive.  Follow the directions on the opposing page (page
25).  Additionally, the following tips can be very helpful:

Tip #1: 

In addition to using the software “slider” to page through the displayed data, you can also use the left-most two
iPAQ buttons to page.  Using the iPAQ left/right rocker “joystick” you can walk the cursor to the left or right on
the chart.  When you reach the edge of the screen, the cursor will “bump” to the next page and reposition itself
to the next pixel (it will appear to jump from one side of the screen to the other) on the chart.

Tip #2: 

When recording a Strip Chart with a chart time of anything over 5 minutes, you will encounter the iPAQ’s power
management limits.  Setting the power management of the iPAQ (under battery operation) to maximum (Today
Screen > Start > Settings > System > Power) you can only operate the iPAQ on battery for a maximum of 5
minutes, without touching some kind of control, before it will turn off.  Also, under System > Settings > Back
light, the maximum setting while battery powered is also five minutes.  When making a Strip Chart recording
longer than 5 minutes you will want to arrange to power the unit from the charger.  Settings under power man-
agement while the unit is under charger power allow the iPAQ to keep running with the screen lit indefi-
nitely.  
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Recording Pen - Green in color when 
the pen is down and writing/recording.

Red in color when pen is lifted and not 
writing.  Note: the pen is always 
responding to the SPL even when not 
writing.



Darkened areas are visual Min/Max 
indicators set in the"Options/Set dB 
Levels" menu.




Step 1 - Select SPL 
Weighting.



Step 2 - Select SPL 
detector response.



Step 3 - Select Recording 
time by tapping Options, 
Chart Speed, and then the 
recording time.


Step 4 - Press the 
"Start/Stop" button.

�

Current SPL and Weighting.


Clears the current Recording 
and resets time to zero.


Save Chart - stops the current Recording and saves 
data to a File.  Brings up a "File Save" screen. 




Completed 5 minute 
Recording.  Upon 
completion, a Save to 
File screen is 
automatically 
displayed.




To view a Saved Chart 
press the "Load Chart" 
button to display the 
above screen, then 
select the desired 
Chart.


Cursor controlled 
by the Joystick or 
by tapping on the 
screen with the 
stylus.


Data at 
Cursor. Press to unload file 

and return to 
recording screen. 

Scroll through data including:

File name, Test date/time, Total 
number of data points, Sample 
interval, Weighting, Max SPL & 
time, Min SPL & time.




The Chart is displayed in an 
expanded form so that each data 
point is represented by one pixel.  
The slide is used to "Page" through 
the data one screen at a time.




Maximum 
data point.


Minimum 
data point.


Viewing a Previously Recorded File


dB per Division and Recording time


Options

Options

Options

Options

Options

Strip Chart Recorder
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Polarity 

Polarity

The IE-33’s Polarity feature allows the user to test for the polarity of a loudspeaker with respect to the signal
source, or with respect to other loudspeakers.

Normally, in a correctly wired system, positive voltage on the “+” output of the signal source (amplifier) should
generate outward speaker cone travel (away from the speaker housing and magnet).  More important to the per-
ception of the listener is the uniform polarity wiring of all speakers in a system.

The IE-33 can help the user to quickly test for correct polarity.  In order to test for polarity a pulse must be gen-
erated and sent through the speakers to be tested.  The IE-33 can generate the special pulse needed to do the
polarity test, though it may be desirable to generate the pulse external to the IE-33 (see Tip #2 below).  To gen-
erate the pulse from the IE-33, connect the IE-33 output (iPAQ earphone output = 3.5 mm phone jack) to an
input in signal processing chain going to the speaker system.  From the Polarity screen (Function > Polarity), tap
the “Pulse On” button in the lower right of the screen.  A special pulse will begin to repeat.

In order to make a valid test, the IE-33’s microphone must be in the direct field of the loudspeaker.  As you move
the microphone close enough to a loudspeaker to be in the direct field, the Polarity display will show “+” Positive
Polarity, or “-” Negative Polarity, or “- - - “ No Lock.  “Positive Polarity” means that the system is wired so that the
loudspeaker is correctly reproducing the output of the amplifier with regard to polarity.  “Negative Polarity” means
the opposite.  “No Lock” means that the microphone is either “confused” because it is not in the
direct field and is seeing too high a level of reverberant energy relative to the direct field, or the overall level of
the speakers is not sufficiently above the room’s noise floor.  These conditions can be corrected by either mov-
ing the microphone closer to the speaker or raising the output level of the loudspeaker.

The most important function of the Polarity test is to assure that multiple loudspeakers in a distributed speaker
system are wired so as to be of uniform polarity.  By starting the pulse signal and then moving from the direct
field of one speaker to the next, the user can quickly confirm that the speakers are correctly wired for uniform
polarity.  The following tips may also prove useful:

Tip #1

When speakers are mounted in a ceiling more than 8 feet above the floor, it may not be possible to move the
microphone into the direct field of the speakers when the microphone is mounted to the IE-33 (unless the user is
on stilts!!).  Using a microphone extension cable and a means of elevating the microphone closer to the speak-
ers can provide the solution (a broomstick and some tape works very well!).

Tip #2

Often, using the pulse generated by the IE-33 can be impractical since a long microphone extension cable, or a
long IE-33 output cable, or both, might be called for in order to get the pulse signal into the sound system while
simultaneously moving the microphone close to the speakers.  In most cases it is easier to use a separate pulse
source instead of the IE-33.  There are several ways this can be done.

One way to do this would be to record the pulse and play it back to the sound system with a player.  Another
would be to use the .wav file of the pulse provided on the CD that comes with the IE-33.  

Yet another way would be to use an external generator that creates a pulse that is compatible with the Polarity
feature of the IE-33.  The Neutrik® “Minirator”, for example, generates such a pulse.

 



Ivie IE-33 Manual

page 29

Polarity 

Step 1 - Connect the Polarity Pulse Generator output of the IE-33 
(iPAQ headphone 3.5 mm stereo jack) to the line-level input of the 
sound system.  Note: The Neutrik Minirator MR1 generator provides 
a compatible polarity generator signal.



Step 2 - Tap the "Pulse On" control to turn on the pulse generator 
and set the output level of the speaker so that it is at least 10 dB 
above the ambient noise.



Step 3 - Position the IE-33 microphone so that it is in close proximity 
to the speaker under test.  If you are too far away from the 
loudspeaker the IE-33 may not be able to achieve a "lock" on the 
polarity.



Step 4 - Read the polarity of the loudspeaker.




The IE-33 is unable to achieve 
a "lock" on the signal.  Make 
sure the output level of the 
speaker is at least 10 dB over 
ambient.  Move the microphone 
closer to the speaker.


The IE-33 has identifed the 
polarity of the speaker as 
"Positive."




The IE-33 has identifed the 
polarity of the speaker as 
"Negative."




OptionsOptionsOptions

Options

Making a Polarity Measurement
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Preference Menu, Scope & Signal Generator

Preferences Menu

The preferences menu (File>Preferences) provides access to a number of special selections and functions.
These are detailed below:

Diagnostics

Choosing Diagnostics provides a temporary setting (resets when the application is closed) that changes the
green/red box under the SPL window in the Main Display to show a numerical indication of the measurement
cycle time.  The number represents the time required, in milliseconds, to complete a measurement cycle.  The
Diagnostics setting is not normally displayed, but can help Technical Support Engineers to better support you if
you call the support center.

Power Average / Arithmetic Average

The IE-33 will perform two types of averaging, depending on the type of measurement and preference of the
user.  The default setting is "Arithmetic".  Power Averaging is most useful when doing transmission loss and
other such measurements where an average of power rather than level is required.  The equations for
each are shown on page 29 across the page.

Oscilloscope (Scope)

The Oscilloscope Function provides a single or dual channel (dual trace, or XY) audio frequency (20Hz to
20kHz) oscilloscope.  Page 31, across, contains illustrations regarding control details.  The oscilloscope is useful
in viewing wave forms of various signals.  To use the oscilloscope function, the "Channel 1 (Line Level)" input
must be selected if a single channel oscilloscope measurement is desired.   If a dual channel measurement is
required,  the "Channel 1 & 2 Scope:  XY/Dual Trace" inputs need to be selected.  Input selection is done in the
following manner:

Input Select 

The  Input Select menu is located under the "File" pop-up menu. There are several inputs on the IE-33 (a micro-
phone connector and two RCA connectors).  This selection area allows the user to select the desired input or
inputs.  Remember that the IE-33 is a two channel device.  The microphone input and Channel 1 line input are
in parallel - both feed Channel 1.  

The Channel 2 input is line level only.

Dual Trace or XY Measurements

When making dual channel measurements in the oscilloscope mode, either dual trace or XY measurements can
be selected using the "Options" pop-up menu.

Signal Generator

The IE-33 provides a simple signal generator.  The output of the generator is available at the iPAQ headphone
jack, and the level of this signal is controlled by the audio level output control of the iPAQ (see iPAQ user
instructions in the iPAQ manual).  Sine, Square, and Triangle wave forms can be selected, as can Pink Noise
and White Noise.  The Main Display in this function shows the waveform of the selected signal type.  See page
31 across for software controls for the Signal Generator.  In addition to the software slider, frequency can also
be selected with the iPAQ's "joystick" left/right controls.  Do NOT plug the output of the iPAQ into a mic input
that has phantom power active.  The phantom power will blow the output of the iPAQ.
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Preferences Menus

Oscilloscope

Signal Generator

Use the "File/Input Select" menu to select Line Level Inputs(s).



To use the Single Trace scope select either Channel 1 or 2 ,Line
Level input and connnect the Scope to that RCA input.



To use either the Dual Trace or XY function select the "Channel 1& 2"  
Scope XY/Dual Trace Input.  Use both RCA input connectors.       




The output of the signal generator is the Headphone jack of the iPAQ.


Waveform display of selected signal source.


Displays an indicator, in milliseconds, of the time 
required for a complete measurement cycle.

Choose one of two different Averaging algorithms 
for the Averaging function.

Arithmetic Average = SPL i
i=1 

N

N
1

Power Average =10 log
10

10
i=1 

SPL 
10

i
N

N

Tap to select the type of signal to be generated.

The output level is controlled via iPAQ volume control.

Display of frequency selected by the slider control.
The slider controls the output frequency of the Generator.

Waveform display controls, 

same as oscilloscope.   

Tapping this control increases 
the "sweep speed" causing the 
waveform to expand on the 
screen.



Tapping this control decreases 
the "sweep speed" causing the 
waveform to contract on the 
screen.



Decreases the input sensitivity 
(vertical) causing the waveform 
to dcrease vertically in 
amplitude.



Increases the input sensitivity 
(vertical) causing the waveform 
to increase vertically in 
amplitude.




XY Display Dual Trace

These controls allow 
the vetical positioning 
of the trace on the 
screen.

With Ch 1&2 Input 
selected the Options 
menus allows 
selection of Dual Trace 
or XY.

Tapping this control to 
switch other applicable 
controls between Ch1 
or Ch2.

Single Trace

Options

Options Options

Preference Menu, Scope & Signal Generator
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Volt Meter

Volt Meter

One of the most useful functions of the IE-33 is its ability to measure electrical signals as well as acoustic sig-
nals.  This can be extremely effective for trouble-shooting and system setup.  As an example, pink noise could
be fed into the first component of a sound reinforcement signal chain.  Using the IE-33, a technician or consult-
ant could step through each of the sound system components.  Levels at inputs and outputs could be measured,
along with the frequency response at every stage.  Crossover points and slopes could be viewed, equalizer
effects noted, level changes assessed and proper signal flow verified.  A wealth of information would be avail-
able by simply probing the electrical inputs and outputs along the signal chain.

The IE-33 is capable of directly measuring preamp level voltages (not to exceed 7.5 volts).  Feeding voltages
higher than 7.5 volts (+19 dBu) directly into an IE-33 could cause damage and void the warranty.  Higher
voltages may be measured only with the addition of an external pad.

Volts RMS

When this mode is selected (see the illustration across the page for visual instructions on selecting various
measurement options), the IE-33 functions as a true RMS volt meter.  Measured voltages are shown simultane-
ously by a digital and an analog display.

Volts Peak to Peak (Volts PP)

In this mode, the IE-33 functions as a peak voltage meter.   Measured voltages are shown simultaneously by a
digital and an analog display.

dB Volts (dBV)

When this mode is selected, the IE-33 functions as a volt meter measuring in dB relative to 1 volt RMS.
Measured voltages are shown simultaneously by a digital and an analog display.

dB Volts Unterminated (dBu)

In this mode, the IE-33 functions as a volt meter measuring in dB relative to .775 volts RMS.  Measured voltages
are shown simultaneously by a digital and an analog display.

Nixie Tube Readout

Using the "Options” menu, a more nostalgic Nixie tube digital display can be selected (see the illustration across
the page).  Choosing the Nixie tube readout effects the digital display only.  The analog display continues to
function without change.

Measuring Voltages and Viewing Spectral Information Simultaneously

When "Volt Meter" has been selected using the Function Pop-up Menu, only the voltage measuring displays
shown across the page are available.  If measuring voltages and viewing spectral information at the same time
is desired, this is also possible.

To view spectral content and measure voltages simultaneously, keep the IE-33 in the  spectrum analysis mode.
Next, use the dB SPL readout box as a stylus button.  Successively tapping this button will toggle the IE-33 from
dB (A, C, or F, depending on what has been selected) to Volts RMS, to Volts Peak to Peak, to dB Volts, to dBu
and back to dB SPL.  The dB SPL readout now becomes the Volt Meter readout.

Of course, for this type of measurement, a line input for the IE-33 should be selected.
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CAUTION-Do NOT exceed input voltage of 7.5 Volts RMS AC (19 dBu)

Step 3- Connect to Ch.1

Line Input RCA connector

Step 2- Under the "File" menu select 

"Input Select", then "Channel 1

(Line Level), then press "OK."

Step 1- Under the "Function"

 menu select "Volt Meter"

Step 4- Tap here to select desired display: Vrms, V peak to peak, dBV, or dBu.

A more nostalgic Nixie tube

readout may be selected via

the "Options" menu.

Ch.1

Indicates Ch.1/Line 1 input is selected

Voltage or dB value
+++ = signal is overange
 ---  = signal is underange

(F) =  No weighting applied

(A) = "A" weighting applied to measurement

(C) = "C" weighting applied to measurement 



V~ = AC volts RMS


V PP = AC Volts Peak-to-Peak 

 dBV = dB relative to 1 volt

 dBu = dB relative to .775 volt

Options

Options

Options Options

Options

OptionsOptions

Options

Volt Meter
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Appendix I:  Simple Trouble-Shooting

Simple Trouble-Shooting

One of the great advantages of the IE-33 is that it functions as a software program on a PDA - the iPAQ (now
HP).  When not running the IE-33 software, you have the bonus of having a standard PDA, with all its inherent
capabilities, software, data, time management and business management tools.  The iPAQ/HP 3950, 3955, 5550
and 5555 are four megabit boxes, and the IE-33 program uses only around 220 kilobits of this memory capacity.
That leaves a lot of capability for other programs, data etc.

The down side is that unless you are careful, the other "stuff" you have in your iPAQ/HP can affect the perform-
ance of the IE-33.  Following are some tips that may help prevent down-graded IE-33 performance.

The IE-33 Display Appears to be Running in "Slow Motion"  

Other applications running in the background can and will degrade the performance of the IE-33.  If the IE-33
seems lethargic, it may be because it is having to share processing time with other applications.  You may have
opened an application and not closed it (even the calendar or task list can slow things down a bit).  

Closing applications in the Pocket PC environment is sometimes not intuitive.  To check on this, close the IE-33
and go to the main "Today" screen of the iPAQ.  Tap "Start" in the upper left corner of the screen.  Now tap
Settings > System > Memory > Running Programs.  You will see a list of the applications that are running in the
background in the iPAQ.  Tap "Stop All" to close all applications. Alternatively, you can select individual applica-
tions and close them one at a time.

When you're done, tap "OK" in the upper right corner of the screen, then tap the "X" in the upper right corner to
return to the Today screen.

The "sure fire" way to shut down all applications is to do a "soft reset" by poking your stylus in the little hole in
the bottom of the iPAQ designed for that purpose.  Doing this will shut down all applications and give you a fresh
start.

Exiting or Shutting Down Other PDA Applications

The convention for shutting down applications in Pocket PC is, well, not what you might expect.  In Pocket PC,
the convenient little "X" in the upper right corner of the screen does not actually shut down the application; tap-
ping the X will just put the application to "sleep" and keep it running in the background.  There is no indication
on the iPAQ standard display that there are applications "asleep" in the background.

In order to shut down a standard application one must go to the "File" menu of the application and tap "Quit" or
"Exit."

Ivie has chosen not to follow the Pocket PC convention.  When you are in the IE-33 software, tapping on the X
WILL shut down the application.

My Data, Applications, Measurements - Gone!  All Gone!

There is a major warning at the beginning of this manual concerning data loss.  We repeat this warning here, so
its unhappy effects may be avoided.  The iPAQ will continue to discharge when sitting on the shelf in the
"Off" position. If the battery runs down, everything in volatile memory will be lost - data, software - everything!
It is wise to keep the IPAQ charged and prudent to store in the iPAQ's non-volatile memory anything that must
not be subject to loss.  You have the choice of whether you store something in volatile or non-volatile memory,
but you may not have enough non-volatile memory available to store everything there you would like to store.  

The IE-33 software comes from the factory loaded into non-volatile memory.
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Step 2 - Press "File/Input Select" 
Menu. 




Step 1 - With the iPAQ inserted into the IE-33J, 
enter into the Calibration mode by  selecting the 
"File/Input Select" Menu.


Step 1 - Remove the iPAQ from the 
IE-33J jacket.  The iPAQ must not be 
connected to the IE-33J in any way. 


Notes on calibration:

1.  Whichever microphone(s) is employed, it is calibrated to the Ivie IE-33 Jacket (IE-33J) and not to the 
iPAQ Pocket PC.   The iPAQ simply remembers and applies the calibration value of the Microphone/IE-
33J combination to the calculations of IE-33 SPL measurements.  Calibration requires that the 
Microphone, Jacket, and iPAQ be kept together as a complete instrument.  You will need to recalibrate 
the instrument if any of the above items are changed.



2.  The IE-33J and its accompanying IE-33M microphone have been calibrated to each other at the 
factory.  A factory Certificate of Calibration is included with each IE-33J/Microphone combination.  If you 
purchased a complete IE-33 including an iPAQ, the calibration number has been entered into your iPAQ 
and you DO NOT NEED to complete the initial calibration procedure below.  If you have supplied your 
own iPAQ, YOU MUST follow the Initial Calibration Procedure below.



3.  Periodic Calibration may be performed in the field if you own an SPL Calibrator.  The procedure for 
this is listed below.


Step 3 - Make sure the Mic to be 
calibrated is selected. 

The iPAQ can remember the calibration 
values for up to six different microphones. 
Press the "Calibrate" button to enter the 
calibration screen.

Step 2 - Select which microphone you are 
going to calibrate to the IE-33J.  The iPAQ 
can remember the calibration values for up 
to six different microphones.


Step 3 - Place the Calibrator (user 
supplied) over the microphone to be 
calibrated.  The IE-33 SPL meter is 
automatically set to FAST response and 
FLAT weighting. The current dB SPL being 
measured by the IE-33 will be displayed in 
real time in the ’Current dB SPL" window.


Step 4 - Using the Up/Down buttons, enter 
the desired calibration level into the 
"Calibrator dB SPL" window.  This would 
include any allowances for altitude and 
barometric pressure should your  
calibration equipment provide these. 

Step 5 - Press the "Calibrate" button.




Step 4 - Using the Up/Down buttons, 
enter the calibration value from the 
supplied "Certificate of Calibration" into 
the "Calibrator dB SPL" window 

and press the "Calibrate" button.


Step 5 - Press the "Done" button.


Step 6 - Press the "OK" button to 
accept the calibration.


Step 6 - Press the "Done" button.




Step 7 - Place the iPAQ into the IE-33J 
and you are now ready to use the 
Calibrated SPL functions of the IE-33.




Calibration Constant - For factory calibration, the CC value should match 
the CC value on your Factory Calibration Certificate.  If you perform your 
own calibration the number may change, and should be recorded for future 
reference.

Calibration procedure for the IE-33

INITIAL CALIBRATION
 PERIODIC  CALIBRATION


Step 7 - Press the "OK" button to 
accept the calibration.


(Without Calibrator) (With Calibrator)

Appendix II:  IE-33 Mic Cal Procedure
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Appendix III:  Data & Program Transfer

IE-33J Jacket:  Data and Program Transfer
If you have purchased the IE-33J (jacket without iPAQ ), you will need to install the IE-33 software on your iPAQ in order to
use the jacket and make measurements.  Even if you have a complete IE-33 package, you will need to install software
upgrades and updates as they become available.  Also, after measurement sessions you may wish to bring IE-33 data files
across from the IE-33 iPAQ to your PC for printing or further data manipulation.

All data and program transfers between the IE-33 iPAQ and your PC are done using Microsoft's ActiveSync software.
ActiveSync is provided on the standard iPAQ CD that accompanies your IE-33 iPAQ.  Follow the instructions provided with
your iPAQ to install the ActiveSync software and create a "partnership" between your iPAQ and your PC.  Questions about
the ActiveSync communication between iPAQ and PC are supported by HP/Compaq.  If you have problems setting up
ActiveSync, contact the Technical Support telephone numbers provided by HP/Compaq.

Assuming that you have Microsoft  ActiveSync installed and running on our PC, and that you can successfully synchronize
your iPAQ with your PC, let's talk about moving data and programs between these devices.

Installing IE-33 Software or Software Updates

Put your IE-33 iPAQ in the sync cradle (or attach the sync cable) and make sure synchronization communication is taking
place.  (As with many things in Windows, there is more than one way to skin a cat.  We're just showing you one reliable way
to do it here.)

Open Windows Explorer and browse to the location of the Ivie "IE-33.exe" file.  This may be on your hard drive if you down-
loaded an update, or on the CD that comes with the IE-33J.  Now, right click on "IE-33.exe" and select "copy."
Now browse to My Computer, Mobile Device, My Pocket PC, iPAQ File Store.   Right click on iPAQ File Store and select
"copy."

You have now copied the only file necessary to run the IE-33 software into the iPAQ File Store area of your iPAQ.  The iPAQ
File Store area in the 3900 and 5500 series iPAQ is a non-volatile storage area.  Even if your batteries are completely
drained, the IE-33 program file will be safely stored in non-volatile memory.

Now that the IE-33 software is installed on your iPAQ, remove the iPAQ from the ActiveSync cradle or cable and turn it on.
Tap "Start" in the upper left corner of the screen.  Tap "Programs."  Select "File Explorer" by tapping on the icon.  The "root"
of the iPAQ file system is "My Device."  Navigate to "iPAQ File Store."  You should see the IE-33 software"exe" file.  Tap and
hold the stylus on the IE-33 file.  Tapping and holding will bring up a menu.  Tap on "Copy."  You have now copied the IE-33
software to the iPAQ's clipboard.

Now navigate back to "My Device," and then tap on "Windows," then on "Start Menu."  In the white screen area, tap and hold
the stylus until a menu pops up.  Now tap on "Paste Shortcut."  You have copied a shortcut for the IE-33 program file into the
Windows Start Menu.  Each time you turn on your iPAQ and tap on the "Start" button in the upper left corner of the screen,
you should see the choice for IE-33 on the main screen.

Data Storage on the iPAQ

The IE-33 default directory for storing files is "Mobile Device."  Virtually all of the Main Memory storage is available if you
store to this directory.  However, this memory area is volatile, meaning that if the batteries totally discharge you will lose the
data files stored there.   If you routinely charge the iPAQ this will never be a problem.  However, if you have data files you
wish to be secure in non-volatile memory, you can you use the Memory Management screen (described elsewhere in this
manual) to select "iPAQ File Store" as the target location for data storage.  Any files stored in iPAQ File Store will be pre-
served in non-volatile memory.

Transferring Data

Data files are stored to the default directory on your iPAQ (in the Mobile Device) directory.  Using Windows Explorer, browse
to My Computer, Mobile Device.  There you will find the stored data files.  Most data files have the extension ".ivi".  Standard
"Scratch" files have the default label "Scratch," followed by the number of the scratch file location. Preferred Curve files use
the label "Preferred," and Peak files use the term "Peak."  Strip Chart data files use the default label "Chart."  However, the
user can name these files to any name when saving them, or rename them at any time.  The ".ivi" file extension must be
maintained or the IE-33 will not be able to read the files.

Select the data files you wish to transfer by holding down the ALT key and left clicking on the desired files. ( The normal
Windows conventions for selecting files apply.) Once the files are selected, right click on any of the selected files and choose
"copy."  Now browse to the location on your computer's hard drive where you wish to locate the data files (usually in the
"IvieXLS" directory), right click on the chosen directory, and choose "paste."   The selected files are now transferred to your
PC.
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Appendix IV:  Making Your Own Mic Cables
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Appendix V:  IE-33 Software Protection

Software Loss

As described in Appendix I, page 34,  the IE-33 software and measurement data can be lost if the unit becomes

fully discharged.  Since the iPAQ does have some nonvolatile memory available for use, the IE-33 software can

be stored as a CAB File in the nonvolatile memory for easy installation, should the software every get lost.  

The following instructions explain how this can be done:

IE-33 CAB File Installation and Use Instructions

In the past, when the IE-33 software became lost, it was possible to easily restore it using the "setup".exe file

through the ActiveSync utility on your PC.  The latest IE-33 software has always been available for down load

from our web site.  While this process has been and continues to be available for use, there is now a second

way to restore your IE-33 software.

Beginning with version 5.8.2, when you run the IE-33 Setup.exe file, a file named "IE33-Setup-v5.8.2ARM.CAB"

will be created in file/directory on your PC from which you began the installation.

Via ActiveSync, you can copy this file to the  "iPAQ File Store"  folder on your IE-33 iPAQ.  The iPAQ File Store

folder is a nonvolatile folder. Even if your iPAQ batteries are run down completely "flat," anything in the iPAQ File

Store folder will remain in the iPAQ.

By going to the iPAQ File Store folder and "double tapping" on the "IE33-Setup-v5.8.2ARM.CAB" file, the IE-33

software will be installed from this non-volatile area into the folder from which the IE-33 application needs to

operate.

Thus, by keeping a copy of the "CAB" file in the non-volatile iPAQ File Store area of your iPAQ, you can have an

"emergency install" ready and in place, even if you find yourself in the field, away from a PC, when you have a

need to reinstall.

Special Note: The act of double tapping on the CAB file will cause the IE-33 application software to be

installed, but it will also erase the CAB file.  If you want to have a permanent CAB file as an emergency install

backup at all times, do this:

Using the File Explorer in your iPAQ, or using File Explorer on your PC via ActiveSync, go the iPAQ File Store

folder.  Create a sub folder titled "Backup".  Put a copy of the IE-33 CAB file in the /iPAQ File Store/Backup 

folder.  Now, if you ever need to do an emergency install, simply make a copy of the CAB file into the /iPAQ File

Store folder, run it (double tap on it) from there.  The CAB file you run will be erased as the install takes place,

but the copy in the iPAQ File Store/Backup folder will remain.
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